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1.1 Introduction 

MigratePro is a powerful application from Software Pursuits, Inc. that makes it easy to perform 
complex file share migrations to new hardware. MigratePro is capable of copying shares and all 
related share permissions between machines. It will also copy local users and local groups to the 
new machine(s) making it easy to move share structures to a new machine(s) that have NTFS file 
security based on local security objects. MigratePro makes a time consuming and error prone 
task simple, quick, and error free. 
 
This Evaluator’s Guide is designed to guide you through the initial setup of MigratePro. By 
reviewing this guide you will become more familiar with MigratePro and how to use the product to 
perform successful share migrations. 

1.2 System Requirements 

MigratePro’s basic operating system and hardware requirements are: 
 

 Supported Operating Systems: Windows Server 2008 R2; Windows Server 2008; 
Windows Server 2003; Windows Server 2003 R2; Windows Vista; Windows XP; 
Windows 7 

 Processor: 400Mhz Pentium Processor or equivalent (Minimum); 1Ghz Pentium 
Processor or equivalent (Recommended) 

 RAM (total for system): 256MB (Minimum); 1GB (Recommended) 
 Hard Disk: 30MB for application files; 20MB+ for database 
 Display: 800x600, 256 colors (Minimum); 1024x768 high color, 32-bit (Recommended) 

 
MigratePro can perform file share migrations from older operating systems such as Windows NT 
4.0 and Windows 2000. However, the software must be installed on a machine running a 
supported operating system. 
 
MigratePro requires a database that is used to store configuration information. The following 
formats are supported: 
 

 Microsoft Access (default) 
 MSDE 2000 / SQL Express 2005 / SQL Express 2008 
 SQL Server 2000 / SQL Server 2005 / SQL Server 2008 

 
MigratePro requires a number of Microsoft components to be installed on the system. The 
MigratePro installer will inspect your system for these components and offer to upgrade or install 
them as needed. 
 
 Microsoft .NET Framework 3.5 with Service Pack 1 
 Microsoft MDAC 2.8 Refresh with Service Pack 1 
 Microsoft Visual C++ Runtime 9.0 with Service Pack 1 
 Microsoft Windows Installer 3.1 
 Microsoft XML Parser 6.0 
 Microsoft Jet 4.0 with Service Pack 8 
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1.3 Contact Information 

If you need further information about MigratePro or need clarification on anything within this guide 
please contact our team and they will be happy to assist you with your evaluation. 
 
Software Pursuits, Inc. 
1900 S. Norfolk Street., Suite 330 
San Mateo, CA 94403 
 
Phone: +1-650-372-0900 
Fax: +1-650-372-2912 
 
Sales e-mail: sales@softwarepursuits.com 
Support e-mail: support@softwarepursuits.com 
 
Technical support is available between 8:00AM and 5:00PM PST Monday through Friday. 

1.4 Installation 

MigratePro should be installed on the new server that will be receiving the data from the migration 
job. MigratePro can be removed from the system once the migration is complete. When migrating 
to a new server, the new machine does not have shares defined. The configuration of the 
migration jobs is made easier having the software on the new machine. You can use a local 
browse panel in the software to select the source directory instead of having to manually type 
administrative share paths.  
 
To install the MigratePro application you would run MigrateProSetup.exe on the machine and 
follow the installer prompts. The installer can be downloaded from 
http://www.softwarepursuits.com/migratepro/download.asp. 
 

Please note that the standard MigratePro trial license includes 3 server licenses 
and 3 workstation licenses. These licenses are valid for 30 days from the date of 
installation or for 5GB of total data transfer, whichever comes first. Please contact 
sales if you need a trial license that covers more machines. 

1.5 Uses for MigratePro 

MigratePro is a powerful application that can be used for a number of different purposes. A few of 
these common uses are outlined below. 

Server, NAS & SAN Migration 

 
MigratePro can be used to perform a data migration from an old server to a new machine, 
network attached storage device (NAS) or an iSCSI based storage area network (SAN). When 
performed manually, such a migration can be time consuming and error prone. MigratePro makes 
the migration process painless. MigratePro can copy local users, local groups, folder shares, 
share permissions, and NTFS compression settings to ensure a smooth move to the new 
hardware. 
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Server Consolidation 

 
MigratePro can consolidate multiple file servers down to a single newer and larger server, NAS, 
or SAN. This results in significant cost savings. Once the consolidation has occurred, fewer 
machines need to be maintained in your network environment. This allows you to reduce your 
power consumption, heat in the server room, and administrative overhead. Merging shares 
together manually is tedious and you can easily retain the wrong version of a file accidentally. 
MigratePro eliminates these difficulties. 

Merge File Shares 

 
If you have multiple shares that contain the same basic files but have differences, you can use a 
Migrate Merge rule to consolidate multiple source directories to one destination path. This 
simplifies your file share structure and makes data easier to find. 

1.6 Configuring a Migration 

Relations are the basic building blocks of the MigratePro application. Each Relation contains the 
root paths (source and destination paths) that apply to that Relation and the options for the 
Relation. Each Relation also contains one or more Rules that tell MigratePro how you want your 
migration performed. The Relation and the Rule are created together in a single wizard.  
  
The Migration Rule is the most common Rule used in MigratePro. This is a general purpose 
migration rule that is used to migrate file shares from an old machine to a new machine. It can be 
used to aide in the migration to new file server hardware and can also be used to consolidate 
multiple file servers down into one new larger file server. This type of consolidation will result in 
power savings and saved resources related to the management of a number of file servers. 
 

The wizards are designed to quickly and easily configure the basic options needed 
to get a Relation up and running. MigratePro is an extremely flexible product with 
many advanced options. Additional options can be specified on the properties 
panels for the Relation after it has been created. 

  
You can create your first Relation by launching MigratePro and going to File | New | Relation to 
launch the Relation Wizard. 

Our Example 

 
For this example, we will be configuring a Migrate job which will migrate a file share named 
SalesData that is stored on a machine named NETTEST to a new machine named 
WINDOWS2008TEST. The data on NETTEST is stored in c:\SalesData and that folder is shared. 
The share name is SalesData as well. We want to migrate the SalesData share including all of its 
settings and data to a new share on WINDOWS2008TEST. 
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The MigratePro software should be installed on the destination machine. The destination machine 
is the new machine which will host the new migrated file share. In this case, that machine is 
WINDOWS2008TEST. 

Name Your Relation 

 
The first panel in the wizard allows you to name your Relation. Enter the name of the Relation 
and an optional description and then click 'Next' to continue. We will refer to 'Evaluation Migration' 
as the name of this Relation for the remainder of this tutorial. 
 

 

Specify the Source Path 

 
The next panel of the wizard is where you define the source path for the migration Relation. This 
is the file share that already exists that you want to migrate to the new machine. 
 

Only one source path can exist per Relation. If you're looking to perform a merge, 
you would create multiple Relations with Migrate Merge Rules. Please see the 
‘Creating a Migrate Merge Relation’ section of this document for further details. 

 
To add a path, click the 'Add' button and a browse panel will be displayed. Browse to the path 
and then click 'OK'. You can also type the path into the browser panel directly. 
 
For this example, the source path is \\NETTEST\SalesData. 
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Click the ‘Next’ button to continue. 

Specify the Destination Path(s) 

 
The next panel of the wizard is where you define the destination path(s) for the Relation. In this 
instance, we are migrating a share named SalesData from the NETTEST machine to the 
WINDOWS2008TEST machine. 
 
To add a path, click the ‘Add’ button and a browse panel will be displayed. Browse to the path 
and then click 'OK'. You can also type the path into the browser panel directly. 
 
For this example, the destination path is C:\SalesData. 
 

 
 
Click the 'Next' button to continue. 
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The wizard configures a Migrate Rule. There is no Rule selection option in the 
wizard. If you are planning on performing a Migrate Merge then you must switch 
the Rule type using the MigratePro desktop after the wizard is completed. Please 
see the ‘Create a Migrate Merge Relation’ section of this document for further 
details. 

Configure Share Migration 

The next panel in the wizard allows you to configure the settings for copying shares to the 
destination machine. 

To migrate shares you must check the box for the 'Migrate folder shares to destination(s)' option. 

For our example job, the default conflict resolution setting is appropriate. These settings are only 
used if a share of the same name already exists on the destination machine. This will not happen 
if you are migrating to new hardware. Further details can be found in the “Rule Properties - 
Migrate Shares” topic in the MigratePro help file. 

 
 
Click the 'Next' button to continue. 

Configure Local User Migration 

 
The next panel in the wizard allows you to configure the settings for copying local users to the 
destination machine. 
 
To migrate local users, you must check the ‘Copy local users’ option. Security features in 
Windows prohibit the retrieval and copying of account passwords. To address this problem, when 
you select the option you must also enter a password that will be applied to all migrated users. 
This is accomplished by checking ‘Set password for migrated accounts’. When the password is 
set, it is configured as a password that must change at next logon. The next time a user performs 
a login on the machine with a local account, Windows will prompt for a password change. 
 
For our example job, the default conflict resolution setting is appropriate. These settings are only 
used if a user account of the same name already exists on the destination machine. This will not 
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happen if you are migrating to new hardware. Further details can be found in the “Rule Properties 
- Migrate Users” topic in the MigratePro help file. 
 

 
 
Click the 'Next' button to continue. 

Configure Local Group Migration 

The next panel in the wizard allows you to configure the settings for copying local groups to the 
destination machine. 

To migrate local groups you must check the 'Copy local groups' option. This will tell MigratePro to 
copy all local groups encountered while copying the files defined for the migration. 

For our example job, the default conflict resolution setting is appropriate. These settings are only 
used if a group of the same name already exists on the destination machine. This will not happen 
if you are migrating to new hardware. Further details can be found in the “Rule Properties - 
Migrate Groups” topic in the MigratePro help file. 
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Click the 'Next' button to continue. 

Configure Migrate Options 

 
This panel of the wizard lets you configure some final options such as how to handle copying 
NTFS compression settings for the files being migrated. In this example, the default settings are 
appropriate. Further details can be found in the “Rule Properties - Migrate Options” topic in the 
MigratePro help file. 
 

 
 
Click the 'Finish' button to finish creating your Relation. 

Previewing Your Relation 

 
When you click 'Finish' to create the Relation you will be prompted to preview the Relation. The 
preview displays the actions that MigratePro would perform without actually doing them. This is a 
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great way to determine if your Relation will perform as expected. You should always preview a 
Relation after making changes.  

1.7 Configuring a Migrate Merge 

 
The Migrate Merge Rule can be used to combine multiple source directories down into one 
destination directory. This is useful for consolidating file shares that have the same name. For 
instance, if you have file servers in multiple offices and each contains the same share then it is 
highly likely that different files exist in each machine's share. If you're moving to a single file 
server that all users can access, then a need exists to merge the content of these shares 
together. 
 

If MigratePro encounters a file with the same name, in the same folder when using 
a Migrate Merge Rule then it will copy the file only if it has a newer date than the 
version of the file which already exists on the destination. The end result is that the 
merged destination directory will have the latest time and date stamped version of 
each file. 

When configuring a Migrate Merge, you must create a separate Relation for each Source path 
that you are merging into the destination. For example, if you are migrating a share named 
SalesShare which is located on C:\SalesData on three different source machines to one 
destination then you will need to create three different Relations. Each Relation will have one of 
the source paths listed and all will have the same destination. This will be detailed further in our 
example. 

The wizards are designed to quickly and easily configure the basic options needed 
to get a Relation up and running. MigratePro is an extremely flexible product with 
many advanced options. Additional options can be specified on the properties 
panels for the Relation after it has been created. 

To create your first Relation, launch MigratePro and then go to the 'File' menu, select 'New' and 
then 'Relation' to launch the Relation Wizard. 

Our Example 

For this tutorial we will be configuring a Migrate Merge job which will migrate a file share named 
SalesData that is stored on c:\SalesData from two different source machines to a destination 
machine named WINDOWS2008TEST. This enables you to "merge" the data from the two 
source directories into a single destination directory on a new server.  



Software Pursuits, Inc. 
www.SoftwarePursuits.com  

11

 

The MigratePro software should be installed on the destination machine (the 
WINDOWS2008TEST in this example). 

Name Your Relation 

 
The first panel in the wizard allows you to name your Relation. Enter the name of the Relation 
and an optional description and then click 'Next' to continue. We will refer to 'Evaluation Migration' 
as the name of this Relation for the remainder of this tutorial. 
 

 

Specify the Source Path 

 
The next panel of the wizard is where you define the source path for the migration Relation. This 
is the file share that already exists that you want to migrate to the new machine. 
 

Please note that only one source path can exist per Relation. 
 
To add a path, click the 'Add' button and a browse panel will be displayed. Browse to the path 
and then click 'OK'. You can also type the path into the browser panel directly. 
 
For this example, the source path is \\NETTEST\SalesData. 
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Click the 'Next' button to continue. 

Specify the Destination Path(s) 

 
The next panel of the wizard is where you define the destination path(s) for the Relation. In this 
instance, we are migrating a share named SalesData from the NETTEST machine to the 
WINDOWS2008TEST machine. 
 
To add a path, click the 'Add' button and a browse panel will be displayed. Browse to the path 
and then click 'OK'. You can also type the path into the browser panel directly. 
 
For this example, the destination path is C:\SalesData. 
 

 
 
Click the 'Next' button to continue. 
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Configure Share Migration 

 
The next panel in the wizard allows you to configure the settings for copying shares to the 
destination machine. 
  
To migrate shares you must check the box for the 'Migrate folder shares to destination(s)' option. 
  
For our example job, the default conflict resolution setting is appropriate. These settings are only 
used if a share of the same name already exists on the destination machine. This will not happen 
if you are migrating to new hardware. Further details can be found in the “Rule Properties - 
Migrate Shares” topic in the MigratePro help file. 
 

 
 
Click the 'Next' button to continue. 

Configuring Local User Migration 

 
The next panel in the wizard allows you to configure the settings for copying local users to the 
destination machine. 
  
To migrate local users, you must check the ‘Copy local users’ option. Windows security features 
prohibit the retrieval and copying of account passwords. To address this problem, when you 
select the option you must also enter a password that will be applied to all migrated users. This is 
accomplished by checking ‘Set password for migrated accounts’. When the password is set, it is 
configured as a password that must change at next logon. The next time a user performs a login 
on the machine with a local account, Windows will prompt for a password change. 
  
For our example job, the default conflict resolution setting is appropriate. These settings are only 
used if a user account of the same name already exists on the destination machine. This will not 
happen if you are migrating to new hardware. Further details can be found in the “Rule Properties 
- Migrate Users” topic in the MigratePro help file. 
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Click the 'Next' button to continue. 

Configuring Local Group Migration 

 
The next panel in the wizard allows you to configure the settings for copying local groups to the 
destination machine. 
  
To migrate local groups you must check the 'Copy local groups' option. This will tell MigratePro to 
copy all local groups encountered while copying the files defined for the migration. 
  
For our example job, the default conflict resolution setting is appropriate. These settings are only 
used if a group of the same name already exists on the destination machine. This will not happen 
if you are migrating to new hardware. Further details can be found in the “Rule Properties - 
Migrate Groups” topic in the MigratePro help file. 
 

 
 
Click the 'Next' button to continue. 
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Configuring Migrate Options 

 
This panel of the wizard lets you configure some final options such as how to handle copying 
NTFS compression settings for the files being migrated. In this example, the default settings are 
appropriate. More details can be found in the ‘”Rule Properties - Migrate Options” topic in the 
MigratePro help file. 
 

 
 
Click the 'Finish' button to finish creating your Relation. 

Change Rule Type to Migrate Merge 

 
Once the Relation is created you need to change the Rule type to Migrate Merge. This is done by 
using the MigratePro desktop application. Branch out the 'Evaluation Migration' Relation by 
clicking the + sign next to the name, displaying the Rule. Select the Rule and on the General tab 
switch the Rule type to Migrate Merge as shown in the screenshot below. 
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Previewing Your Relation 

 
When you click 'Finish' to create the Relation you will be prompted to preview the Relation. The 
preview displays the actions that MigratePro would perform without actually doing them. This is a 
great way to determine if your Relation will perform as expected. It is recommended that you 
preview a Relation after making changes. 

Configuring the Second Relation 

 
A Migrate Merge Rule is only used when you are merging the contents of two source directories 
down into a single destination directory. As a result, you must create multiple Relations, one for 
each source path. The simplest way to accomplish this task is to copy and paste the existing 
Relation. This will carry over all the settings of the first Relation you created. This can be done 
using the Edit menu or the Ctrl + C and Ctrl + V keyboard shortcuts. 
 

 
 
You must then rename the Relation name and modify the Root Paths so it has the new source. 
This can all be done from the General tab of the Relation. Simply change the Relation name in 
the field on the top of the panel and then highlight the source path you want to change. For this 
example it is the \\nettest\salesdata path. Clicking the 'Edit' button will allow you to select a new 
source path. In our example, the new source path would be \\xptest\salesdata. 
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When you are done making your changes to the Relation, click the 'Apply' button to save them. 

You should also verify that the correct source and destination paths are defined on the Roots tab 
of the Migrate Merge Rule as in the screenshot below. 
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For each source path you are migrating, you would create that same number of 
Relations. For example, if you were merging 4 source directories from 4 different 
servers into one destination directory then you would have 4 Relations created 
with Migrate Merge Rules. 

How to Run the Relations 

 
Each of the Relations must now be run one after another. This can be done manually but it is 
easier to create a Schedule with all the Relations selected. The Schedule will then run the 
Relations one after another until all the Relations have finished. 
  
For details on configuring a Schedule please see the ‘Creating a Schedule’ section of this 
document. 
 

 

1.8 Creating a Schedule 

   
A Schedule is used to specify when one or more Relations should be run. Schedules are very 
flexible and can be configured to run a Relation at a specified time, specified time intervals, or 
only on specific days of the month, days of the week, weeks of the month, or months of the year. 
This allows a very granular level of control over when your migration jobs are run. 
  
In this example we will create a Schedule that will run the Evaluation Migration Relation created 
in the ‘Configure a Migrate Relation’ section of this guide. We will configure the Schedule to run 
once at midnight. This is a common scenario for MigratePro where a user configures the 
migration job and then schedules it to run in the middle of the night when no one will be 
accessing the shares. 
  
To start configuring your Schedule, go to the File | New | Schedule. 
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The wizards are designed to quickly and easily configure the basic options needed 
to get a Schedule up and running. MigratePro's Schedules can be configured with 
many advanced options that are not displayed in the wizard. These additional 
options can be configured using the property panels for the Schedule after it has 
been created. 

Name Your Schedule 

 
The first panel allows you to name your Schedule. Enter the name of the Schedule and an 
optional description. Then click “Next” to continue. 
 

 

Select What Relations to Run 

 
This next panel is where you specify which Relations you would like the Schedule to run. Specify 
these Relations by checking the box next to their name(s). 
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Setting Schedule Frequency 

The next panel provides options on how often you want the Schedule to run. 

By default, the 'Run this job only once' button is selected. This is the option which we will use to 
configure the Schedule to run once at midnight. The option to 'Schedule this job to run multiple 
times' can be used to tell the Schedule to run once an hour for example. 

 
 
Click 'Next' to continue. 

Setting the Schedule Start Date 

The next panel is where you specify the start date and time for the Schedule. The default time for 
all new Schedules is 12:00AM. The default time can be configured in Tools | Options on the 
Scheduler tab if you would like it to be something different. 

You can pick a future date and time for the Schedule to run. You can enter in a date and time 
manually or you can pull down the menu to select the date from a calendar. 

In this case we will select today's date and midnight. 
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Click the 'Finish' button to create your Schedule. 

Modifying Your Schedule 

Your Schedule is now complete and has been created. You can make changes to the options of 
your Schedule in the main SureSync window by first clicking on the Schedule you wish to modify 
and then you can look through the tabs on the right side for options to change. Pressing F1 while 
on any tab will bring up context sensitive help, describing the options on the tab in detail. 

You must have a Scheduler running for your Schedule to run at the scheduled 
times. A Scheduler can be installed by going to the Tools menu, selecting 
Schedulers, clicking on the Install button and then providing a username and 
password for the Scheduler to run under. 

 


